Takeoff Guide

Tutorial to get started with the AxioVision Imaging System
(Based on Release 4.8 June 2009)

This Takeoff Guide has been prepared for Carl Zeiss by Imaging Associates Ltd.
www.imas.co.uk
How to Use This Tutorial

This tutorial has been prepared to help you get started with your AxioVision imaging system. You are invited to work through the topics, step by step. Some of the functionality of AxioVision has been deliberately left out of the guide; the idea is to explain the main trunk and branches of the program from an application point of view. You are left to explore the twigs on your own. For a description of the full functionality please refer to the manual or help file accompanying the system.

AxioVision can support various cameras each with their own characteristics, however in software versions later than AxioVision 4.6 analog cameras are not supported. In this guide only the AxioCam interface is described in detail.

Tips, shown in italic text, will give hints and short cuts.

Notes, shown in italic text, will give additional information and explanations.

For further information please contact your local Carl Zeiss representation.
## Contents

1. **Introduction to the AxioVision Environment** ...........................................1  
   Image Types ............................................................................................................... 2

2. **Image Acquisition using the AxioCam Camera** .......................................3  
   2.1 Getting Started ........................................................................................................... 3  
      Exposure ..................................................................................................................... 4  
      Focus ..........................................................................................................................4  
      White Balance (applies only to color cameras) ........................................................... 5  
      Acquiring an Image ..................................................................................................... 6  
   2.2 AxioCam Features...................................................................................................... 6  
      Resolution ................................................................................................................... 6  
      Frame ..........................................................................................................................6  
      Monochrome or Color ................................................................................................. 7  
      Black Reference .......................................................................................................... 7  
      Shading Correction ..................................................................................................... 7  
      Gain Factor ................................................................................................................. 8  
      Sharpening.................................................................................................................. 8

3. **Saving and Archiving Images** ................................................................5  

4. **Image Display and Adjustments** .............................................................11  
   Image Size................................................................................................................... 11  
   Image Display Properties.......................................................................................... 11  
   Image Splitter Display Window ................................................................................. 13  
   Image Gallery View................................................................................................... 14

5. **Image File Types and Exporting and Importing** ....................................15

6. **Scaling and Scale Bars** ............................................................................16  
   Changing the scale bar color .................................................................................... 18  
   Automatic scaling ........................................................................................................ 18

7. **Annotations** ..............................................................................................19

8. **Workflow Customization & Short-Cuts** ..................................................20

9. **Backing up your data** .................................................................................22

10. **Automation** ...................................................................................................23

11. **Interactive Measurement** ........................................................................24

12. **Multidimensional Acquisition (optional)** .............................................27  
   12.1 Multichannel ............................................................................................................. 28  
      Exposure ..................................................................................................................... 28  
      Hardware Settings ..................................................................................................... 28  
      Channel Actions ....................................................................................................... 29  
      Extended Parameters .............................................................................................. 29  
      Saving Your Experiment ......................................................................................... 29  
      Acquiring the Images .............................................................................................. 30  
      Viewing Complex Images ....................................................................................... 30  
   12.2 Z-Stack ...................................................................................................................... 30  
   12.3 Time Lapse ............................................................................................................... 32  
   12.4 General Remarks...................................................................................................... 32

13. **Importing Multidimensional Images from another File Format** ..........33

14. **Image Editor – Change Image Dimensions** ............................................35

15. **Glossary** .......................................................................................................36
1 Introduction to the AxioVision Environment

AxioVision is a powerful and flexible software package for capturing, archiving and preparing images for publication. Whilst AxioVision can perform many complex tasks it can be customized so that you only see the information and controls you need. Important information in Chapter 8 will explain how you can set up your system for easy, efficient workflow.

For the purposes of this tutorial we need to set up a standard configuration. Start AxioVision by double clicking on the AxioVision icon on your desktop and compare your screen with the picture below.

Note: If you do not see this icon on the desktop then click on the Microsoft® Windows Start button and look in the Carl Zeiss Vision program group.

If your AxioVision window does not look similar to the picture above select Options in the Tools menu and Reset Window Layout, then restart AxioVision.
Microscope Configuration Program (MTB2004): AxioVision allows you to control and read the settings from motorized ZEISS microscopes. Before you can do this you need to tell AxioVision about your microscope using MTB2004. This has probably been done for you when the system was installed and is outside the scope of this guide. If you are not using a motorized or encoded microscope set the microscope to other.

Note: MTB2004 has a Simulate Hardware check box. You can use this to simulate a motorized microscope i.e. AxioVision will behave as if a motorized microscope was connected.

Referring to the picture on the previous page, the areas you see in the AxioVision window have the following functions:

**Toolbar:** these contain groups of functions belonging together e.g. annotation functions. You can switch toolbars on and off by right clicking in a toolbar and you can drag them around the screen to “dock” them at the edges or leave them “floating”. To keep things simple we have switched most of the toolbars off.

**Workflow:** these are groups of functions put together to perform a particular task e.g. capture, annotate and save an image. You can make up your own workflows to make repetitive tasks easier to perform. This is explained in Chapter 8.

**Workarea:** this is a quick way to access frequently used functions and control panels e.g. microscope control or scaling.

**Document area:** this is free space for images and information. You can hide or show the Workflow and Workarea using the buttons on the toolbar.

**Image Types**
AxioVision is a very powerful image acquisition environment. Most of the features will be explained using standard images, i.e. single color or monochrome images. However AxioVision can acquire more complex image types as follows:

**Multichannel:** multiple monochrome images which can be pseudo-colored and superimposed, usually acquired for various fluorochromes or contrast techniques.

**Z-Stack:** a series of images acquired at different focus positions.

**Time Lapse:** a series of images acquired over a period of time.

**MosaicX:** a series of overlapping tiled images acquired over a defined area.

**Mark&Find:** a series of images acquired at different predefined positions on a sample.

These image types can also be combined e.g. as a multichannel z-stack. The acquisition of complex images is covered in Chapter 12.
2 Image Acquisition using the AxioCam Camera

The first step is to capture an image from the camera attached to your microscope. If you are working on an AxioVision system which is off-line i.e. not connected to a camera, you may want to skip this section.

AxioVision can acquire images from a variety of cameras; most of these will use a specific interface called FireWire. All systems supplied by Carl Zeiss will have appropriate connection for the Carl Zeiss range of cameras. Some older camera types will require specific capture boards to be installed in your computer. Some use a TWAIN interface which is a piece of software supplied with the camera and is used to capture the image. You can start the TWAIN interface inside AxioVision and import the captured image.

The first thing to do is to check that AxioVision is configured for use with the camera you are using.

In the Acquisition menu select the camera.

The AxioCam camera range are very flexible high performance digital cameras. You can use them for bright field and low light level fluorescence imaging to acquire images at a range of resolutions. A detailed explanation of the camera technology is beyond the scope of this guide.

Note: Most modern cameras communicate with the computer via a FireWire cable, however, older cameras such as the AxioCam HRc and HRm Rev.1 and 2 AxioCams communicate with the computer via a fiber-optic cable to reduce electromagnetic noise effects and therefore have a separate power supply. You should take care not to kink this cable sharply. If you need to disconnect the cable at either end then cover the exposed cable ends and sockets with the caps provided to keep dust out.

2.1 Getting Started

Set up a sample under the microscope and ensure that the light is directed to the camera.

Activate the camera controls by clicking on the relevant camera button in the acquire menu or by selecting it from the work area. In this instance we will be using an AxioCam HR.
Next click on the live image icon on the toolbar to open the live image window. You may or may not see an image in the live window. Next we need to set exposure, focus and white balance. For convenience, many of the routine controls such as measuring the exposure and automatic white reference are accessible from buttons on the toolbar in the live window or click on the live image properties icon to do the camera adjustments.

**Exposure**

The AxioCam range of cameras can adjust to various illumination levels by varying the exposure time. Ensure that the Auto Snap box is not checked and then click on the Measure button to let the camera find the optimum exposure level. You can further adjust the exposure manually using the top slider control (the range can vary from 400 μs to 60 s depending on the type of camera). If you find that image brightness after using Measure is always too dark or too bright for your purposes you can adjust the level e.g. set to 90% for a darker image (underexposed) or 110% to overexpose using the lower slider control. If you have Auto Snap box checked the exposure will be adjusted automatically before each single snap. Checking the Auto Live box enables continuous exposure time adjustment in the live image.

*Note: The region of the image used to measure the exposure is the same as the focus region (see following section). If the focus window is inactive then the whole image will be used. Therefore, you may want to position this over the regions of interest before clicking the Measure button to set the exposure.*

**Focus**

Focusing is often difficult when using high resolution or low light level cameras. Because of the time required to transfer high resolution images to the computer, or the long exposure times required for low light levels, it is not possible to update the live image frequently enough. To overcome this, the AxioCam range of cameras use a standard resolution and electronic gain (rather than a long exposure) when in live mode. Thus, the live image you see will be relatively low in resolution and noisy but will be updated frequently enough to allow focusing and stage movement. The final acquired image will be at full resolution as set in the Frame tab of the camera driver interface (see page 6).

You can vary the update speed of the live image by clicking on the button on the toolbar at the bottom of the live image (fast, medium and slow options). Live image quality will decrease as update speed increases.

*Tip: The toolbar above can be used to adjust the display contrast and brightness, see Chap.4.*
AxioCams also have a focus meter. Right click in the live image window to toggle between spot meter/focus bar on/off.

As you change focus the green bar will move, the red line shows the peak value reached. The focus meter measures the sharpness of edges within the green box. To get the best results you should position the box over an area containing some structure or detail, the focus meter cannot work when the focus box is positioned over a uniform background area.

Tip: This region is also used to set the illumination level for the exposure Measure function.

White Balance (applies only to color cameras)

The color spectrum of the illuminating microscope lamp varies with voltage and hence the color of the resulting image will also vary as the lamp intensity is changed. AxioCam can automatically correct for this as follows.

Move to a region of your sample which contains an area with no color i.e. white or light gray. Click on Interactive. As you move the mouse pointer over the image it will change to a dropper. Now click on the area which should be white (or light gray).

This will adjust the camera color balance to show the true colors of the sample. These settings will remain in effect for subsequently acquired images however you may need to repeat the white balance procedure if you change microscope settings. Alternatively click on Automatic in which case AxioVision will search for an area which is close to white and use it for correction.

The 3200K button will set the camera color balance for use with illumination of this color temperature. This can also be considered as a default setting and should be used if it is not possible to do a white balance e.g. in the case of fluorescence imaging where there will not be a white area.

Tip: You can manually adjust the color offset by using the slider, thus making the image more yellow (warm) or blue (cold).
Acquiring an Image

Click on the **Frame** tab on the camera control panel.

Set the resolution to 1300x1030 and click on the **Snap** icon. For convenience you can also find this on the toolbar at the bottom of the live window. You can now close the live window and you should see the high resolution acquired image.

**Tip:** Right click in the live image and select **Close after Snap** to automatically close the live window after acquiring an image.

Now that you have successfully acquired an image we can take a look at some of the other features of the camera.

---

### 2.2 AxioCam Features

#### Resolution

Click on the **Frame** tab on the camera control panel.

All AxioCams allow images to be acquired at a variety of resolutions i.e. number of pixels. The AxioCam HR uses patented technology to achieve high resolution and color quality by scanning the CCD chip.

Choose a resolution to suit your requirements. You may want to capture a very high resolution image for publication or you may want to save disk space and processing time by capturing a medium resolution image. Although very high resolution images can be acquired, many people find that 1300x1030 pixels are sufficient for "every day" requirements.

If you are working with very low emission level fluorescence samples you may find that exposure times become unacceptably long and sample bleaching becomes a problem. In this case you can binning. Binning is a method of altering the camera resolution by combining square groups of pixels (2x2, 3x3 etc) and outputting them as one pixel in the image. The result is a proportional increase in sensitivity with an associated reduction in resolution. Binning has the added advantage of increasing sensitivity without increasing noise.

#### Frame

You may want to capture a region of interest from the camera rather than the full frame.

Click on **Refresh Overview** to capture the full image into the window on the right, then click on **Select Frame** and select a window size. Now move the window around the full image to an area suitable for focus fine adjustment. You can interactively resize the region of interest.
Monochrome or Color

If you are using a color camera you can switch it to monochrome mode by clicking the B/W button. This is useful when working with fluorescence samples.

Note: Switching a color camera to monochrome mode does not increase its sensitivity. Monochrome cameras have several times more inherent sensitivity than color cameras as there is no color mask in front of the sensor chip.

Black Reference

Click on the General tab on the camera control panel.

Your image can be further improved by correcting for the dark current i.e. the level of signal when no light is reaching the camera.

Close the light path to the camera (it is essential that no light can get to the CCD camera) and click on Black Reference. Now the camera takes a few seconds to acquire an image at the maximum resolution which is then used to correct subsequently acquired images. This is only necessary for exposures greater than approximately 2 seconds.

Re-open the light path to the camera.

Shading Correction

If you acquire an image from a clear field e.g. a clear glass slide, you may find that the image is not uniform e.g. it may be slightly brighter in the centre of the field than at the edges. This is due to optical aberrations and variations in illumination. The Shading Correction can correct for this non-uniformity.

Move to a clear part of your microscope slide and click on Shading Correction. You may want to slightly defocus your microscope to remove any small specks. When the Enable box is checked all images will be automatically corrected for shading non-uniformity.
Note: The Shading Correction is correcting for non-uniformity of illumination (shading) across the image whereas White Balance is adjusting the color.

Tip: If you do not use a clear field to set the Shading Correction any dark objects or features in the reference image will be seen as bright areas in all subsequent images as AxioVision will try to correct the apparent non-uniformity. This can give the impression that there is some dust in the microscope or on the camera surface.

Gain Factor

If you have low light levels and find that your exposure time is unacceptably long you may use "binning" as described previously, however this sacrifices resolution. An alternative is to apply gain to the image using the controls at the top of the General tab. This will increase the sensitivity of the camera at all resolutions, but in this case, as previously discussed, you will also increase the noise in the acquired image.

Sharpening

By checking the Enable box you can apply sharpening to your image automatically upon acquisition. The slider can be adjusted to determine the strength. You can also choose to use the same sharpening tool as a post processing function from the Processing menu.

Tip: Sharpening will alter the data contained within your image. If you are subsequently going to analyze your images, we recommend that you do not use this as a post-acquisition function. The post processing sharpening may be useful to make images look good for publication purposes.

Note: Upon acquisition sharpening is not available for the AxioCam ICc range of cameras from Carl Zeiss.
3 Saving and Archiving Images

If you have worked through the previous chapters you can now capture some images to use as examples when working through this section. If not example images are on the DVD delivered with your system. You can open them using the Open Image option in the File menu. In principle any image can be used, you will see that all common image file formats are supported.

Capture an image from your camera then click on Info View at the bottom of the image window.

The Info View shows information associated with your image. If you have a motorized or encoded microscope some of the details will have been automatically entered. You can enter further details as required including specific comments relating to your experiment for example..

Click on Save or Save As in the File menu. The default folder will be the last folder used to save an image and is likely to be in the My Documents area of your computer. Create a new folder in the My Documents area called "AxioVision Images" and save your image here. It will be saved by default in ZVI format. As well as the optimized ZVI format, AxioVision allows the image to be saved as a Tagged Image File (*.tif), a Microsoft Windows Bitmap (*.bmp) or as a JPEG compressed file (*.jpg) – you can choose the level of compression required in the JPEG here. You can also choose to compress the ZVI and TIFF image formats using the compression factor setting in the Save As window. Very high values generate very small files. However, in this case image quality may be significantly reduced. There is no compression available for the BMP file format.

Note: TIFF compression is loss-free and the file size is barely affected.

In the three other file formats (TIFF, Bitmap and JPEG) you can choose to either Burn-in annotations, Apply display mappings and Convert to 8-bit. This will be discussed further in Chapter 5.
Note: The advantage of using My Documents is that it is specific to the user logged on to the computer and therefore reduces the risk of confusion between users as you won’t see another user’s My Documents folder.

Once you have saved your image you can close the image window.

Repeat this to acquire and save several images in the AxioVision images folder. Now we can use the browser to review these saved images. Click the Browser button and navigate to AxioVision images.

The AxioVision browser will create small thumbnail images. You can then open any image by double clicking it or by clicking on the Load button.

You can view the information associated with each image by clicking on one of the Change View buttons – try all three of these to see what they do, use the arrow buttons to change the image. You can change the information associated with images here.

Images can be deleted using the red cross.

Tip: If you save new images in this folder the thumbnails will not automatically be updated; use the Refresh button to update all thumbnails.

You can open several images and view them in separate windows, alternatively maximize one of the image windows and use the tabs to switch between images.

Use the Gallery button on the toolbar to open a gallery of open images.

Tip: Hit F6 to swap quickly between open images.
4 Image Display and Adjustments

In this section we will look at various image display modes and adjustments.

Image Size

Load an image from your images folder.

Right click the mouse in the image to see the context menu. Try the various image sizing functions to see the effect:

**Zoom In / Zoom Out** (also F7 and F8).

**Auto Zoom**: display the entire image inside the display window.

**Normal View**: displays the image at its true resolution (no zoom) i.e. one image pixel per screen pixel.

**Full Screen**: Press the Esc key to exit this view.

Try using the **Navigator** window. This is particularly useful when viewing large images e.g. those which do not fit on the display area. You will probably want to drag the **Navigator** window out to make it a bit bigger, and then move the red square around inside it.

Image Display Properties

You may want to adjust the contrast and brightness of the displayed image. This is particularly useful when viewing high bit depth images i.e. images with more gray values, as obtained from the AxioCam camera range.
Right click in the image to see the context menu. Select **Properties** to open the **Properties** window and select the **Display** tab.

You use this window to modify the way in which your image is displayed. The histogram shows the number of pixels at each intensity level for each color (RGB). Contrast, brightness and gamma can be controlled via the sliders or by dragging the curve on the histogram.

- Click on **Linear** for the default display curve.
- Try selecting **Min/Max** to stretch the contrast to the histogram maximum and minimum.

**Tip:** **Best Fit** is similar to **Min/Max** but it will stretch the contrast a little further since it ignores the extreme tails of the histogram. This is set at 5% by default but can be changed.

Close the **Properties** window when you have finished adjusting the image.

**Note:** images acquired with a monochrome camera will only have one histogram line relating to the grey values as there is no RGB data

If you have modified the display properties of an image you will be asked if you want to save the changes when you close it, but don’t worry you haven’t really changed the image data. The updated display properties are saved with the image so that it will be displayed in the same way if it is reopened, but the image data has not been changed and the display properties can still be put back to linear.

**Image Window Toolbar** - The toolbar at the bottom of the image window provides shortcut buttons for zooming and display adjustment.

**Note:** You can set the display properties for the live mage window. The acquired image will inherit these properties.
**Image Splitter Display Window**

You can also compare up to 12 images using the splitter window. The button is on the standard toolbar or can be accessed via the **View** menu. In the **View** menu select **Windows** and **Splitter Display**. With your images already open, click on the **Gallery** button to select the image for each pane in the splitter window. Check **Synchronize** to adjust all of the images simultaneously.

The down arrow allows the number of images compared to be changed.

By clicking on this button an additional window containing some **Extended settings** is opened. From this window it is possible to create images containing the selected images side by side. If the original images are Z-Stack images then the entire Z-Stacks can be viewed side by side by selecting **Create Z-Stack image**. It is the same for time lapse images, just select **Create Time lapse image**. You can also control the spacing between the images and the color used to separate the aligned images.
Image Gallery View

The Gallery view enables the individual images in a multidimensional image to be viewed simultaneously.

In the image below, the individual DAPI, FITC and TRITC channels are viewed as the original monochrome image – the fourth image is the original images pseudo-colored and merged.

By selecting Channel Color, the individual channels can be pseudo-colored – i.e. the DAPI image will be displayed as blue.

This example is a three channel Z-Stack image and by selecting Z-Stack it is possible to view the merged images at all z positions. If the example image were a time lapse then selecting Time Lapse would allow all time points to be viewed simultaneously.

By holding down the Shift button and scrolling the wheel button of the mouse all images are zoomed in/out. If an image is selected it becomes identified by having a white spot in the centre of the image. Once selected you can hold down Ctrl and scroll the wheel button of the mouse to zoom in on each individual image at the same time.
It is possible to use **Gallery View** to edit the image dimensions (see Chapter 14). In the **Gallery View**, a single image can be selected by clicking on the image – a white spot is superimposed on the image. Additional images can be added to the selection by holding down the Ctrl button and clicking on the required images. Complete Z-Stacks can be generated by clicking on the first z position you want and, whilst holding down Shift, clicking in the last z position of interest. In this example below all three channels in six z positions have been selected. When **Extract Selection** is clicked the selected images will be extracted and inserted into a new image.

If you select **Create Image**, a new image of the current view will be produced.

5  Image File Types and Exporting and Importing

So far we have saved and loaded our images as ZVI files. Now it’s time find out how to export the images in more common file formats which can be used by other imaging and document processing packages.

A number of different file types or formats have been developed for storing images to disk, AxioVision supports all major formats. However, its default native format is a new image format ZVI.

- **Why develop yet another image format?**

As imaging technology has advanced so have the requirements of users therefore the current formats are not able to offer the flexibility required. For example, if you annotate your image with a scale bar and text you need to burn this information into the image when it is stored as a TIFF file, thus the annotations can’t be removed or changed at a later date. The new ZVI format keeps all graphic information separately so that it can always be changed and the underlying image is not destroyed. The ZVI format can also handle the full range of bit depths, multichannel images and image sequences.

- **How do I export my images in another image format?**

If you just want to export a single image then you can simply use **Save As** in the **File** menu and select the file format. However if you want to export multidimensional images it becomes more complicated as each image in the ZVI file must be exported as a separate image. In this case you need to use the function described below.

First ensure that the image to be exported is the active document (i.e. click on the bar at the top) then use **Export** in the **File** menu. Refer to the online help for a detailed description of this function, we will just cover the main points.
Insert a **Base name** and a **Save in location** – all images contained within the ZVI will be exported to a file with a name starting with the base name. If you click **Create project folder** a folder will be created with the **Base name** which will contain all exported images.

**Mode** allows you to export some of the image e.g. a specified channel, time, z position or all images.

**Generate merged images** will combine multichannel images as overlaid color images.

**File Type** - select the output file format.

**Convert to 8 bit** (only seen when saving as a *.tif) will convert a higher bit image down to an 8 bit TIFF.

**Gray scale** will convert a color image to a black and white image.

**Apply display mappings** will retain the current display property settings (see Chapter 4).

**Burn in Annotations** will merge any graphics into the image before it is saved.

Click **Start** to export the images.

---

**Tip:** To convert more than one image, select **File, Export and click on Batch. Choose Add files type**, select the files to be exported then click **Run batch**.

---

- **How do I import an image from another format?**

AxioVision will open all of the common image file formats mentioned in Chapter 3 simply by selecting a file using **File and Open Image**. You can subsequently save the image in the ZVI format. If you want to import a sequence of images (such as a Z-Stack) then refer to Chapter 13.

---

6 **Scaling and Scale Bars**

There are two ways of creating scale factors in AxioVision. Firstly you can manually define and store scale factors using images acquired of a stage micrometer. Secondly you can use automatic scaling and allow AxioVision to calculate the scaling factor for you. Here we will discuss manual scaling first, followed by automatic scaling.

Select **Scaling** from the **Workarea**. Here you can select an existing scale and apply it to the currently open image or activate it in which case it will be applied to all images subsequently captured.
Before we can make a new scale we must acquire an image of a micrometer scale using the objective lens we want to calibrate.

Note: Scaling should be done using the standard camera resolution (approx. 1300x1000 pixels). If you then switch the camera to a higher or lower resolution a new corresponding temporary scale factor will be created.

Click Advanced and then New to start the scaling wizard.

If your scale image was active it will appear in the image window, otherwise select it from the gallery or load it from a file. Once you have selected your image, click Next.

Now select the **Single distance** calibration method.

Enter the calibration distance and units.

Draw a line on the image between two points corresponding to the calibration distance entered.

Finally enter a name for your scale and it will be entered in the scale list.

---

*Note: The calibration assigned is stored with the image.*
click on the scale bar button on the toolbar and drag a line on the image to draw a scale bar (any length in x or y).

Use this to draw a scale bar on your image of a scale and check its accuracy (remember to apply your new scale to the image first).

Try loading another image from your archive, apply this calibration and draw a scale bar.

If you want to make your scales available to all users then copy the files from your user data folder to the workgroup data folder (see chapter 9 for more information about this).

---

*Note: You can calibrate the system independently in x and y directions although this is often not necessary since the calibration factors will be similar in both directions. However you should confirm this for yourself on your imaging system.*

### Changing the scale bar color

Right-click in the image and select the **Properties** option and the **Attributes** tab. Click on **Scale bar** and change the text and line color attributes using the buttons at the bottom of the dialog box.

If you have drawn several scale bars or other graphics you can select any one and change its attributes independently.

### Automatic scaling

The size of the pixels in a digital microscope image is determined by the following microscope components and camera parameters:

- Magnification of the objective used.
- In the case of an upright and inverted microscope: magnification factor of the optovar/tube lens used, or, if applicable, magnification factor of an optovar cube in the reflector turret.
- In the case of a stereomicroscope: zoom factor.
- Magnification factor of the camera adapter(s) used.
- The physical size of the pixels on the digital microscope camera’s CCD sensor.
- Binning mode used on the digital microscope camera.

AxioVision and the active MTB2004 configuration allow you to take advantage of the benefits of automatic scaling.
If you are using a motorized or encoded microscope with a correct MTB2004 and camera configuration, AxioVision will know which components have been used and the automatic scaling calculates the appropriate scale for you. You do not need to do manual scaling.

Automatic measurements are very convenient and generally sufficient for most applications. Manual scaling can still be done for all microscope types and, in contrast to the “theoretical” automatic scaling, a measured scaling takes very small manufacturing tolerances into account. If you require highly precise measurements we recommend working with measured scalings.

Automatic scaling can be turned on and off by navigating to Measure on the Menu toolbar.

7 Annotations

We have already annotated an image by adding a scale bar. You may want to add further annotations using the options in the Annotations menu (or switch on the Annotations toolbar – see Chapter 8)

Select the drawing tool you require and then draw on the image. Click the right mouse button to finish drawing a shape. If you want to change or move the graphics then click simply left click on the item and move it. The colors and fonts for each graphic object can be set independently by right clicking in the image and selecting the Properties option and the Attributes tab (see Chapter 6: adding a scale bar).

Tip: Use Undo and Redo in the Edit menu to correct mistakes.

Note: If you store the image in ZVI format the graphics are stored as separate objects with the image i.e. they can be changed at a later date. For further information on image file types see Chapter 5.

Frequent Annotations: Use this option to add annotations to image sequences e.g. time lapsed since start of a time sequence.
8 Workflow Customization & Short-Cuts

Having mastered many of the AxioVision functions you may want to customize the interface to make repetitive tasks easier and to help out other users who have well defined requirements. The best way to do this is to hide all unnecessary toolbars (right click on a toolbar) and make a workflow to suit your application. It’s very easy to do and may save a lot of time in the long run.

You can make many workflows in AxioVision but note that they are specific to the person who is logged on to Microsoft Windows. This has the advantage that each user can set up AxioVision to suit their needs. If you want to make a Workflow for somebody else you will need to use their log in and then start AxioVision before you make the workflow.

In the Tools menu click on My AxioVision.

Select the Workflow tab.

Click on New Workflow and enter Image Capture as the name.

Click on the Image Capture workflow on the left side of the dialog box.

Now we can add tools to the workflow by selecting them from the right hand side and clicking on Add.

In the example above we have added:
- Live from the Acquisition group
- Snap from the Acquisition group
- Navigator from the View/Windows group
- Scale bar from the Annotations group
- Save from the File group

You can change the order of the tools on the Workflow using the Move Up/Move Down buttons.

Close the dialog box and you will see the Image Capture workflow added to the Workflow area.

Workflows can be exported, see Chapter 9 on backing up your data.

Tip: Further discussion of customization is beyond the scope of this guide. However you may like to try assigning a shortcut key to a function using the Keyboard tab in the My AxioVision dialog box.
There is also a built in short-cut to save an image to disk with an incremental name.

In the **Tools** menu select **Options** and then the **Naming** tab.

Enter an image name prefix.

Select the number of digits for the incremental number (e.g. 2 = 01-99)

Choose additional designations from the **Format-ID** list, e.g. %U will add the Microsoft Windows user name.

In the **Tools** menu select **Options** and then the **Storage** tab. The folder for **Auto save** can be typed in (or selected via Microsoft Windows tree by clicking on **...**).

In the **Tools** menu select **Options** and then the **Acquisition** tab. It is possible to keep the settings for the acquired image or alter the bit depth.

If **Auto save** is checked, captured images will automatically be saved in the place identified in the **Storage** tab, with the name identified in the **Naming** tab. We recommend that you save the images as **Carl Zeiss Vision Image (*.zvi)** files but you can automatically export the images to different file formats.

If you assign a keyboard short-cut to the **Snap** function you can acquire and save an image with a single key stroke.
9 Backing up your data

As with any computer system you need to make adequate back-up copies of your data. This consists of settings, data and images. You need to know where these are so that you can copy them to your back-up media e.g. CD-ROM, ZIP disk or network folder. As long as the images are stored in ZVI format they will contain all of the additional information and scaling information within the image file. Backing them up is simply a matter of copying the image files to your back-up media, then you can either copy them back again to restore the data or use the browser to open an image directly from the back-up media.

By default AxioVision will store your images, data and settings in the My Documents area of your computer. This has the advantage that different users can log on using their own log on names and work independently. However you may want to make some files available to everyone e.g. scaling, so Microsoft Windows provides an additional My Documents area for All Users which is accessible to everyone. However you can decide to store your images and other data anywhere on your computer.

To find out where the default folders are click on Options in the Tools menu and select the Folder tab. You will see that folders are defined for user data and templates (usually the user’s My Documents folder) and also for Workgroup data and Workgroup templates (usually All Users My Documents).

To change folders or to see the full path, click on or click on Folder info.

You need to back-up the files in these folders; they contain scaling calibration files and microscope setting files.

In addition to backing up your images and calibration files you may want to keep a copy of your customization features i.e. Workflows, short-cut keys, screen layout. You can do this by exporting your configuration.

Click on Import/Export Configuration in the Tools menu.

Select Export in the first screen.

Now check all the boxes except the last and click Next.

Enter a file name.

To import a set-up use the same function but select Import on the first screen.

Note: The last option (Save to Zip file) creates a zipped up configuration file. This is useful if you need to e-mail your configuration to a colleague or to support staff.
10 Automation

If you have a microscope from Carl Zeiss with some encoded or motorized features you can read or control the settings from within AxioVision however a detailed discussion of these features is beyond the scope of this guide. You will need to configure the microscope module using the Microscope Configuration program before you can use these features, usually this will have been done by the installation engineer.

To control the microscope you have various options:

Click on **Microscope** in the workarea and use the control panel.

Use the options in the **Microscope** menu or **Microscope** toolbar – these can be left out on the desktop for easy access.

The potential of microscope remote control is realized when we start to save and recall microscope configurations. This means that we can then construct image acquisition sequences using different microscope settings e.g. settings for various fluorochromes.

To save a microscope setting:

Activate the **Settings Editor** in the **Tools** menu.

The example highlights a setting for FITC.

Click **New** to make a new setting.

Select microscope components from the right side and add them to the group of selected settings.

Click on the **Edit** button for each selected component to set it.

In this case the reflector is set to the TRITC block and the internal reflected light shutter is open.

*Tip: Be careful about the components you select e.g. we would not usually want to save the focus motor position as this would always be used when we activated the setting. Generally, select the minimum number of settings required.*
When using fluorescence you may find it useful to make a setting which closes the reflected light shutter to prevent bleaching e.g. called shutter closed. In this case you only need the internal shutter (in the closed position) in the group of selected settings.

If you want to check your setting, click the Apply button (or Tools, Settings, User) to activate it. The microscope will then be adjusted according to the setting.

Microscope settings can be added to the workflow (see Chapter 8) for ease of use.

11 Interactive Measurement

There are various advanced measurement options for AxioVision. This chapter only describes the standard interactive measurement functions found in the Measure menu. We will use the Interactive Measurement Wizard.

Open an image.

Click Interactive Measurement from the Measure menu and then select Configure Tools...

AxioVision provides you with various tools for defining an area to be measured whether the radius of a circle, the area of a circle or the distance between two points for example. The Configure Tools dialog allows you to select measurement Features for each individual drawing tool.

You can also choose which measurement values are shown as a graphic overlay by choosing Draw Features from within the specific feature. Once the settings have been edited, they can be saved for either individual users or for the workgroup.
To use a configuration, select Measure, Interactive Measurement, **Load Tools**. Click on ![browse button] to browse the various saved configurations and select the one you want to use. Click **OK**.

Click on select **Measure, Interactive Measurement, Start Measurement**. This opens the active image in the interactive measurement window, as shown on the following page.
Select a drawing tool, we have indicated the **Outline spline** tool here. The features chosen in the configuration step are now displayed.

![Outline spline tool and Toolbar Interactive Measurement module](image)

Draw around the features to be measured.

Click **OK** to close the measurement window. The desired measurement data is now shown on the image.

The data can be viewed by right clicking in the image and selecting **Properties**, and then selecting the **Measurement** tab as shown below.

![Properties tab](image)

Here you have the option to send the data to the clipboard for subsequent pasting into another application (such as Microsoft Excel).

Below are some typical region measurement descriptions and their meaning.

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Area of region</td>
</tr>
<tr>
<td>Center X</td>
<td>Centre of gravity x coordinate</td>
</tr>
<tr>
<td>Center Y</td>
<td>Centre of gravity y coordinate</td>
</tr>
<tr>
<td>Perim</td>
<td>Perimeter</td>
</tr>
<tr>
<td>BoundWidth</td>
<td>Width of rectangle drawn around object</td>
</tr>
<tr>
<td>BoundHeight</td>
<td>Height of rectangle drawn around object</td>
</tr>
<tr>
<td>Diameter</td>
<td>Diameter of a circle with equivalent area</td>
</tr>
<tr>
<td>Radius</td>
<td>Radius of a circle with equivalent area</td>
</tr>
<tr>
<td>DensMeanR</td>
<td>Mean intensity of red color channel</td>
</tr>
<tr>
<td>DensMeanG</td>
<td>Mean intensity of green color channel</td>
</tr>
<tr>
<td>DensMeanB</td>
<td>Mean intensity of blue color channel</td>
</tr>
<tr>
<td>DensStrR</td>
<td>Standard deviation of intensity of red color channel</td>
</tr>
<tr>
<td>DensStrG</td>
<td>Standard deviation of intensity of green color channel</td>
</tr>
<tr>
<td>DensStrB</td>
<td>Standard deviation of intensity of blue color channel</td>
</tr>
</tbody>
</table>

The measurement values and graphics will be saved with the image when you close it. If you re-open the image you can view the measurement data by right clicking in the image and selecting **Properties**, and then selecting the **Measurement** tab.
12 Multidimensional Acquisition (optional)

AxioVision is a very powerful image acquisition tool allowing multidimensional images to be captured. Three optional multidimensional acquisition modules are available:

**Multichannel**: Up to 32 images can be captured and overlaid with a separate pseudo-color assigned to each channel. This is generally used to capture and combine images of different fluorochromes or to combine fluorescence and bright field (typically phase contrast) images.

**Z-Stack**: Images are acquired for a range of equally spaced focus positions. This allows imaging through a thick section or of a rough surface. Often these images are further processed using Deconvolution to improve the resolution prior to 3D reconstruction or using extended focus techniques to create a single image containing the most ‘in focus’ data from the Z-Stack series.

*Note: Deconvolution, 3D Reconstruction (Inside4D) and Extended Focus are optional modules available for AxioVision and a description of their use is outside the scope of this guide.*

**Time Lapse**: Images are acquired at equally spaced time intervals allowing dynamic processes to be observed and recorded.

These multidimensional acquisition modes can be combined so that we can acquire image data sets for several fluorochromes through a focus range and for a series of time intervals. They are then saved as a single file in ZVI format (see Chapter 5).

*Note: There is a further multidimensional acquisition option called Mark&Find. This is used with a motorized microscope stage to move to a series of pre-defined positions prior to image capture. However a description of this module is also outside the scope of this guide.*

Click on Multidimensional Acquisition in the Workarea; the example below shows all of the options, however, you may only have some of them available.

The **Experiment** tab gives access to the general settings and the **C, Z** and **T** tabs contain settings for Multichannel, Z-Stack and Time Lapse respectively.

The first thing to do is to enter an image name. In this example the first image set acquired will be called Experiment_1, a second image will be called Experiment_2 and so on.

Before we look at the other experiment controls we will see how to set up each of the Multichannel, Z-Stack and Time Lapse modules.
12.1 Multichannel

Even if you are not actually using more than one channel you should still review this section; you will need to set up a single channel to be able to go on and use the Z-Stack or Time Lapse modules.

Click on the C (Channel) tab to see the Multichannel settings.

Note: You don’t need any microscope automation to use this option.

If this is the first time the option has been used you will see a single channel (‘1’).

Settings

In this example we have selected DAPI from the list of dyes. If your dye is not listed you can type any Dye name in this box.

The blue color is associated with DAPI but you can change it if you wish.

Now we can enter a name, in this case My_DAPI. Very often the name will be the same as the dye, but we may for example have two DAPI filter sets and want to call them DAPI_Narrow and DAPI_Wide.

Tip: Make sure your AxioVision window is large enough to show all of the buttons as shown in the example image.

Exposure

This allows us to set the camera exposure time for this channel. You have three options:

Auto – the exposure is calculated automatically before the image is acquired. This will always give you a well exposed image but the exposure time may be different for each image and a brief additional calculation exposure is performed before each acquisition which may increase sample bleaching.

Note: You should not use this mode for Time Lapse if you want to make relative intensity measurements. Also you should not use when capturing Z-Stacks if you want to subsequently use Deconvolution.

Fixed – the value in the Time box is used. To find out what this value should be click on the measure button.

Camera – the current exposure value set in the camera control dialog (see Chapter 2)

Hardware Settings

This section only applies if you have a motorized microscope. First you must set up microscope settings for the dyes you want to use (see Chapter 10). Now you can attach a setting to be used for acquisition to this channel e.g. move filter block to DAPI and open the reflected light shutter, and a setting to be used after acquisition e.g. close reflected light shutter.

If you have the Autofocus optional module installed you can perform an autofocus before each acquisition. Otherwise the current focus position will be used.

Tip: Click on the Go buttons to check the hardware setting.
Channel Actions
Once you have set the channel up you can save it to the channel pool (Save to pool) and subsequently load it.

Click on Duplicate to make a copy of My_DAPI. You can change the settings here from now on, for example to set-up a FITC channel.

Tip: You can temporarily inactivate a channel by right clicking on its colored tab. The tab will gray out and have a cross through it. To re-activate the channel, right-click on the tab again.

Extended Parameters
We have now set up the basic channel parameters however there are more parameters available. Click on Extended parameters to open the Extended Channel Parameters window shown below.

Here you can select more settings for the My_DAPI channel we have just made. For example we have an additional exposure setting which will start a series with an automatic exposure and then use it unchanged for subsequent images.

We might want to use these channels again in another experiment so before you close this window click on Save to pool to add each channel to the Channel pool.

If you now click on Channel pool you will open the Channel pool and you can add any channel from the pool into your current experiment by clicking on Add to Experiment.

Saving Your Experiment
Once you have set up your channels you should save your experiment settings so that you can always repeat this type of image capture.

Go back to the Experiment tab.

Click on Save and enter a name for your experiment e.g. DAPI-FITC.

Now you can click on the Load button to reload this image acquisition setup.

Note: ReUse allows you to use the experiment settings from an image captured previously.
Acquiring the Images

It seems like we have put a lot of work in so far and still not acquired an image, but it will all be worth it.

If you have a motorized microscope and have used the Hardware Settings to assign microscope configurations to each channel then all you have to do is to hit the Start button and your automated multichannel image acquisition will begin.

If you have a manual microscope then select the first channel (e.g. My_DAPI), set up your microscope for DAPI and click on the Snap button. Repeat this for each channel.

Tip: You can repeat and overwrite channels if necessary.

You can continue to acquire images and they will be automatically named for you.

Viewing Complex Images

If you have acquired multidimensional images you will see additional display controls at the bottom of the image window.

In this example we have a three channel Z-Stack image. All three channels are overlaid and we are showing the first image in the Z-Stack.

You can view different slices using the Z scroll bar or the player buttons to the right.

To view a selection of the channels click on the corresponding colored button e.g. click on button 3 to switch it off. To change the pseudo color for any channel, right click on the corresponding button and choose your color.

If you click on this button you can view each channel separately without pseudo-color. You must switch to this mode before you can adjust the display settings as described in Chapter 4.

12.2 Z-Stack

Click on the Z tab to see the Z-Stack settings.

Note: You must have a motorized focus on your microscope to use this option.
There are two ways to define the focus range; in the example shown we have clicked on the **Center** mode.

Move the microscope focus to the centre of the focus range; this is a matter for your judgment.

Click on the **Center** button to enter the current position.

Now decide how many slices you want to acquire and the spacing between them and enter the values. In our example we will acquire 15 slices spaced at 0.5 μm. This means that the center slice will be number 8 and we will acquire 7 above and 7 below this position.

You can use the **Z-Stack navigation** controls at the bottom of the control panel to step the microscope to each position.

**Tip:** Click this button to see a live image for focusing.

The alternative way to define the focus range is **Start/Stop** mode. In this case you should move the microscope to the top and bottom of the range and then click on the **Start** and **Stop** buttons. These have deliberately not been called ‘top’ and ‘bottom’ as it doesn’t matter whether you enter the top position as **Start** and the bottom position as **Stop** or vice versa.

**Tip:** If you are combining multichannel and Z-Stack acquisition, AxioVision will normally acquire all the z images for channel 1 then all the z images for channel 2 and so on. This gives the fastest acquisition but may suffer from slight z registration problems. However if you check **All Channels per Slice** AxioVision will acquire all channels for the first z position and then move on to the next z position and so on. This will give exact z registration but usually increases acquisition time.

**The Optimal distance** button will set the ideal slice spacing to match the z resolution of the optics you are using. This is also known as the Nyquist criteria as it takes into account the double over-sampling required by this theorem. It depends on the numerical aperture of the objective lens and the wavelength of the illumination. Therefore, you must have an encoded or motorized objective nosepiece which has been properly configured so that AxioVision knows which objective is being used. You must also have entered all the dyes you are using in the multichannel setup.

Generally you do not need to use this button as it may result in too many slices being acquired but it is not worthwhile sampling more finely than this setting. However you should use this setting if you subsequently want to use the AxioVision Deconvolution option to improve the resolution of your images since double oversampling is a requirement condition for the algorithm.

See “Saving Your Experiment and Acquiring the Images” in the Multichannel section to capture the images.
12.3 Time Lapse

Click on the T tab to see the Time Lapse settings.

Note: You do not need microscope automation to use this option.

In our example shown here, we have chosen to acquire images from 10 time points, one every 15 seconds. Therefore, the total duration of the experiment will be 135 seconds (the first time point is at t=0).

Alternatively we could click on Cycles in which case we would enter the interval and total duration and then the number of cycles would be automatically calculated.

See “Saving Your Experiment and Acquiring the Images” in the Multichannel section to capture the images.

Note: The interval is measured from start of image acquisition to the start of acquisition of the subsequent image. If you are acquiring multichannel, Z-Stack or long exposure images at each cycle you must ensure that the time required to acquire the images does not exceed the interval between acquisitions.

12.4 General Remarks

Returning to the Experiment tab there are just a couple more things worth pointing out.

Saving and reloading your experiments makes it very easy for a less experienced person to use the system. This is particularly useful for multichannel acquisition; for Z-Stacks you will probably have to reset the Center or Start/Stop positions each time.

You can temporarily disable the Z-Stack or Time Lapse elements by un-checking the boxes. This is useful to grab a single image as a preliminary check.

We described how to attach microscope settings to a channel in the Multichannel section. You can also attach a microscope setting before starting the experiment and after e.g. you might use a motorized binocular head to switch the light to the camera before the experiment and back to the eyepieces after the experiment.
13 Importing Multidimensional Images from another File Format

It may be necessary to import images into AxioVision. If the images are single images in any of the file formats mentioned in Chapter 5 they can simply be opened using File and Open (or Open Image).

However you may wish to import more complex Multidimensional images. In the File menu, select Import to ZVI. This wizard allows you to import various file formats in any combination of Multichannel Fluorescence, Z-Stack and Time Lapse.

**Step 1: Setup Image Dimensions**
identify the type of image to be imported (Multichannel Fluorescence, Z-Stack or Time Lapse). For the purposes of this description, all import steps will be discussed. In Scale lateral (X) box the number of μm/pixel can be set. It may be necessary to create a different y scaling which can be achieved by ticking the Different Y scaling box. If the μm/pixel relationship is unknown, the scaling dialog box can be ignored but any subsequent measurements will be incorrect. Click Next.

**Step 2: Channel Setup** allows you to choose up to 8 different image channels in which you can select the dye, assign a color and name the channel. Additional channels can be added with Add channel - click Next when all channels have been identified.

**Step 3: Z-Stack parameters** allows the number of slices and the distance between theses slices needs to be entered. Alternatively the number of slices and the Z-Stack height can be used. It is possible to add Extended parameters, including the magnification, numerical aperture of the lens and the immersion medium. Again if any of these parameters are unknown, the import process can proceed but any future calculations which use these values will be affected.

**Step 4: T Parameter Setup** enables you to enter the number of cycles and either the time interval between each image acquisition or the time duration of whole experiment.
**Step 5: Compose Images** allows you select the files to be imported. Locate the position of your stored files and select the images to import. Once all of the images have been selected, click **Get Selected**. The selected images now appear in the bottom half of the panel. Click on **Consistency** to check that the images are compatible. At this stage it is possible to check the images that will be imported by viewing them in **Preview**.

Select **Finish** at the bottom to import the images:

Once the images have been imported they can be saved as ZVI files via **File, Save** (or **Save as**).
14 Image Editor – Change Image Dimensions

This command allows you to edit a Multichannel, Z-Stack or Time Lapse image should some images not be required (for instance a Z-Stack may have extremities with little or no data). Image Editor is opened from the Edit menu and Change Image Dimensions or by right clicking on an image and selecting Change Image Dimensions. It is also possible to edit the image dimensions from the Image Gallery View (see Chapter 4).

**Step 1: Choose action** selects whether selected images are to be kept or removed by ticking the relevant box.

**Step 2: Channel Selection** allows you to choose which channels you want to remove or keep.

**Step 3: Reduce pixel resolution** allows you to dramatically reduce the volume of data when you are working with very large images, without necessarily losing information that you need. From the drop-down list box for X, select the desired reduction factor.

**Step 4: Z-Stack selection** allows you to remove selected images from your Z-Stack. If you wish to skip over this step, you can deselect the Enable this action check box. To select the desired z plane images either type in the From and To fields the positions of the relevant images or to view images click on Get player position and select image/s using the slider. It is possible to select every “nth” image in the selected range (meaning that every nth image will be kept/removed).

**Step 5: Time Point Selection** allows you to remove certain time points. Again this step can be skipped by deselecting the Enable this action button. The method of time point selection is similar to the Z-Stack selection. Select Preview and/or the Finish button.

The images generated can be subsequently saved via File, Save (or Save as).
### 15 Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Camera</td>
<td>Camera which produces an analog video signal.</td>
</tr>
<tr>
<td>Annotation</td>
<td>Graphics (e.g. text and arrows) drawn on top of the image.</td>
</tr>
<tr>
<td>Binning</td>
<td>Technique used to increase the sensitivity of the camera by adding together groups of adjacent pixels.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>Number of intensity values resolved e.g. 8 bits = 256 levels, 12 bits = 4096 levels, 14 bits = 16384 levels.</td>
</tr>
<tr>
<td>Camera Interface</td>
<td>A board inside the computer which reads the image in from a digital camera.</td>
</tr>
<tr>
<td>CCD</td>
<td>Charge coupled device – solid state technology used for camera sensors.</td>
</tr>
<tr>
<td>Channel</td>
<td>Settings for image capture of a specific fluorochrome or contrast technique.</td>
</tr>
<tr>
<td>Clipboard</td>
<td>A Microsoft Windows facility used by many applications to exchange data.</td>
</tr>
<tr>
<td>Context Sensitive Menu</td>
<td>A menu specific to a particular window, usually activated by clicking with the right mouse button inside the window.</td>
</tr>
<tr>
<td>Co-site Sampling</td>
<td>Technique used to improve color image quality by moving the CCD chip.</td>
</tr>
<tr>
<td>Dark Current</td>
<td>Inherent background signal from camera when no light is reaching the sensor.</td>
</tr>
<tr>
<td>Deconvolution</td>
<td>An image restoration technique in which the blurred information from planes above and below the plane imaged is removed.</td>
</tr>
<tr>
<td>Dialog Box</td>
<td>The window associated with a function used to set up its parameters.</td>
</tr>
<tr>
<td>Digital Camera</td>
<td>Camera which directly produces a digital image.</td>
</tr>
<tr>
<td>Drag and Drop</td>
<td>Click on an object with the left mouse button, hold the button down and move to a new location (drag), then release the button to drop the object in its new location.</td>
</tr>
<tr>
<td>Drop Down Menu</td>
<td>List of options associated with a menu item accessed by clicking on a down arrow to the right of the entry line.</td>
</tr>
<tr>
<td>Encoded</td>
<td>An encoded device (e.g. objective nosepiece) can tell the computer which position it is in, as distinct from 'motorized' in which case the computer can also move the device.</td>
</tr>
<tr>
<td>Extended Focus</td>
<td>Software technique in which the sharpest (most in focus) features from a Z-Stack are combined into a single image.</td>
</tr>
<tr>
<td>Fluorochrome</td>
<td>Marker dye which fluorescence.</td>
</tr>
<tr>
<td>Form</td>
<td>Template used to display information from the archive on screen.</td>
</tr>
<tr>
<td>Frame grabber</td>
<td>Device, usually a single board, which digitizes a video image and stores it in computer memory.</td>
</tr>
<tr>
<td>Gallery</td>
<td>Collection of miniature images which show the contents of all the image stores.</td>
</tr>
<tr>
<td><strong>Gamma</strong></td>
<td>Defines the relationship between the intensity values in the image and the intensity of the display. If Gamma is set to 1.0 then the relationship is linear. Often a Gamma value less than 1.0 is used e.g. 0.5.</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td>Drawings and annotation drawn on top of an image.</td>
</tr>
<tr>
<td><strong>Graphics plane</strong></td>
<td>Place where the graphics are drawn.</td>
</tr>
<tr>
<td><strong>Histogram</strong></td>
<td>Graph of the number of pixels (y axis) against intensity value (x axis).</td>
</tr>
<tr>
<td><strong>Kohler Illumination</strong></td>
<td>Method for setting up the microscope condenser.</td>
</tr>
<tr>
<td><strong>Live Image</strong></td>
<td>Direct display of the image from the camera.</td>
</tr>
<tr>
<td><strong>Merge</strong></td>
<td>Copy contents of the graphics plane into an image.</td>
</tr>
<tr>
<td><strong>Microscanning</strong></td>
<td>Technique used to acquire very high resolution images by shifting the camera chip.</td>
</tr>
<tr>
<td><strong>Multichannel</strong></td>
<td>Several separate images (usually fluorochromes) captured from the same field within a sample using different filter sets and overlaid.</td>
</tr>
<tr>
<td><strong>Nyquist Theorem</strong></td>
<td>States that to measure a given frequency you must sample the waveform at twice that frequency, in terms of imaging it means the pixel size should be half the size of the theoretical resolution.</td>
</tr>
<tr>
<td><strong>Overlay</strong></td>
<td>See graphics plane.</td>
</tr>
<tr>
<td><strong>Pixel</strong></td>
<td>Single element of a digital image. The value of a pixel sets the intensity or color of the point in the image.</td>
</tr>
<tr>
<td><strong>Pseudo color</strong></td>
<td>Artificial color applied to monochrome images.</td>
</tr>
<tr>
<td><strong>Scroll Bars</strong></td>
<td>Controls at the side of an image or window which change the window view point.</td>
</tr>
<tr>
<td><strong>Shading Correction</strong></td>
<td>Correction of an image for illumination or background non-uniformities.</td>
</tr>
<tr>
<td><strong>Sync</strong></td>
<td>Synchronization signal. In the case of a monochrome signal, this is usually added to the video signal (composite sync.). In the case of a separated R, G, B color signal the sync signal may be added to the green channel or it may be separate.</td>
</tr>
<tr>
<td><strong>Thumbnail</strong></td>
<td>Small copy of an image used in image galleries etc.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Collection of function buttons.</td>
</tr>
<tr>
<td><strong>White Balance</strong></td>
<td>Process by which the image from a color camera is adjusted to give true colors.</td>
</tr>
<tr>
<td><strong>White Reference</strong></td>
<td>Background image used for shading correction.</td>
</tr>
</tbody>
</table>